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Sarcomeres are the structural units of the contractile apparatus in cardiac and
skeletal muscle cells. Changes in sarcomere characteristics are indicative of
changes in the sarcomeric proteins and function during development and dis-
ease. Assessment of sarcomere length, alignment, and organization provides
insight into disease and drug responses in striated muscle cells and models,
ranging from cardiomyocytes and skeletal muscle cells derived from human
pluripotent stem cells to adult muscle cells isolated from animals or humans.
However, quantification of sarcomere length is typically time consuming and
prone to user-specific selection bias. Automated analysis pipelines exist but
these often require either specialized software or programming experience. In
addition, these pipelines are often designed for only one type of cell model in
vitro. Here, we present an easy-to-implement protocol and software tool for au-
tomated sarcomere length and organization quantification in a variety of striated
muscle in vitro models: Two dimensional (2D) cardiomyocytes, three dimen-
sional (3D) cardiac microtissues, isolated adult cardiomyocytes, and 3D tis-
sue engineered skeletal muscles. Based on an existing mathematical algorithm,
this image analysis software (SotaTool) automatically detects the direction in
which the sarcomere organization is highest over the entire image and outputs
the length and organization of sarcomeres. We also analyzed videos of live
cells during contraction, thereby allowing measurement of contraction param-
eters like fractional shortening, contraction time, relaxation time, and beating
frequency. In this protocol, we give a step-by-step guide on how to prepare,
image, and automatically quantify sarcomere and contraction characteristics
in different types of in vitro models and we provide basic validation and dis-
cussion of the limitations of the software tool. © 2022 The Authors. Current
Protocols published by Wiley Periodicals LLC.

Basic Protocol: Staining and analyzing static hiPSC-CMs with SotaTool
Alternate Protocol: Sample preparation, acquisition, and quantification of
fractional shortening in live reporter hiPSC lines
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INTRODUCTION

Healthy adult muscle tissue is characteristic of striated sarcomeres (the contractile ma-
chinery) which are aligned and well organized along the length of each cell and the tissue
axis. However, in conditions such as toxicity, disease, and during development, sarcom-
eres are less organized and achieve a decreased contraction force (Ribeiro et al., 2015).
Cardiomyocytes and skeletal muscle cells can now be derived routinely and with high
efficiency from human induced pluripotent stem cells (hiPSCs) using a variety of proto-
cols based on defined culture media and differentiation factors (Birket et al., 2015; Mills
et al., 2017). However, hiPSC-derived cardiomyocytes (hiPSC-CMs) and hiPSC-derived
skeletal muscle (hiPSC-SM) are often structurally and functionally immature which is
why the induction of maturation via new methods is widely studied (Jalal, Dastidar, &
Tedesco, 2021; Yang, Pabon, & Murry, 2014). This immaturity and contractile deficiency
are associated with a reduced sarcomere length, which is ∼2.2 μm in adult human car-
diomyocytes but usually around ∼1.65 μm in immature hiPSC-CMs (Cohn et al., 2019;
Gerbin et al., 2021; Giacomelli et al., 2020; van der Velden et al., 1998). Similarly, many
cardiac genetic diseases, such as hypertrophic cardiomyopathy, which is caused by mu-
tations in myosin heavy chain or myosin binding protein C3, affect muscle sarcomere
structure and organization such that there is loss of contractile force (Cohn et al., 2019;
Wijnker et al., 2016). To use hiPSC-derived muscle in disease or toxicity models, it is
therefore highly relevant to assess and quantify sarcomere length and organization, and
preferably in combination with a measurement of the contractile properties.

Here, we describe an unbiased and rapid method for quantifying sarcomere length and
organization in multiple muscle cell types and models, based on the SarcOmere Texture
Analysis (SOTA) algorithm. SOTA was originally developed by Sutcliffe et al. (2018)
to quantify sarcomere organization and length for static images in a MATLAB script.
We made a user-friendly application in Python called SotaTool, which aims to enhance
the performance of SOTA by implementing various background subtraction methods,
adding an alignment index and including automated segmentation. In contrast to other
approaches, the method does not require regions of interest (ROIs) to be pre-defined or
selected, or images of fluorescent sarcomeres to be aligned manually (Cao, Manders, &
Helmes, 2021; Pasqualin et al., 2016; Peterson, Kalda, & Vendelin, 2013). While current
algorithms typically rely on manual user input per image to indicate the directionality
of the sarcomeres, SotaTool detects the optimal angle automatically, reducing analysis
time and selection bias. We show here how this software tool can be applied to many
different datasets that contain sarcomeric striations: Immunostained cardiomyocytes, 3D
tissue engineered skeletal muscles (3D TESMs), and phase-contrast images of primaryStein et al.
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Figure 1 Broad overview of input and read-outs of the SotaTool. (A) SotaTool detects the corre-
lation between pixel values at a range of offsets. This range is calculated for 180 degree angles so
the algorithm can autodetect recurring patterns like striations in immunofluorescent images stained
for α-actinin. For all angles the maximum is determined as sarcomere organization and the offset
value of this maximum is the average sarcomere length over the entire image. Scale bar = 5 μm.
(B) If an image contains recurring patterns in multiple directions (e.g., in unaligned cell culture),
the optimal angle to define the sarcomere length cannot be calculated properly. An optional image
segmentation step resulted in a higher success rate of the sarcomere detection over 14 images of
non-aligned hiPSC-CMs. Scale bar = 15 μm. (C) Videos acquired from beating neonatal rat car-
diomyocytes can be analyzed as single timeframes, enabling the user to find important contractile
parameters: Fractional shortening, beat duration, and beat-to-beat interval. Scale bar = 10 μm.
hiPSC-CMs, human induced pluripotent stem cell-derived cardiomyocytes.

neonatal rabbit CMs. The analysis gives information on the sarcomere organization and
length. Aside from static images, this tool can also be used on videos or fluorescent
reporter cells, broadening the output to sarcomere shortening, contraction duration, and
beat rate (Fig. 1). The approach presented here addresses several problems associated
with other methods: (1) underrepresentation of the entire image available for each muscle
cell, (2) tendency for selection bias, and (3) time required for analyzing large datasets.

We describe step-by-step application and validation of this protocol as a sarcomere length
quantification method across multiple in vitro platforms, from static 2D and 3D struc-
tures in fixed tissues and cells to fractional shortening in videos of contracting muscle.
We also provide step-by-step protocols for preparation and imaging of hiPSC-CM and
skeletal muscle cultures that support robust analysis (Fig. 1). We expect this new tool to
reduce manual labor and time necessary for multiple muscle research applications, thus
facilitating discoveries on how sarcomere structure is controlled and affected by drugs
and disease. Stein et al.
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BASIC
PROTOCOL

STAINING AND ANALYZING STATIC hiPSC-CMs WITH SotaTool

SotaTool is broadly applicable across multiple in vitro platforms in which sarcomeres
are visible in contractile cells by phase contrast or fluorescent microscopy. This section
describes the steps of plating, fixing, immunofluorescence staining, imaging, and analyz-
ing 2D hiPSC-CM cultures (Fig. 2). For live cultures, the required steps are described in
the next section. Here, we immunostained hiPSC-CMs for α-actinin but other sarcom-
eric proteins can also be stained. Better results were obtained with proteins that are part
of the Z-discs or M-lines (e.g., titin, myomesin) than with A-band proteins (actin, tro-
ponin). Differentiation and immunostaining of skeletal muscle differs from the protocol
described below and can be found in Iuliano et al. (2020). The acquisition and analysis
(steps 29-49) are identical for all models.

Materials

Human induced pluripotent stem cell-derived cardiomyocytes (hiPSC-CMs), either
from commercial sources (e.g., Ncardia, cat. no. K0104; Fujifilm, cat. no. 11713;
Axol Bio, cat. no. ax2508) or differentiated in-house using a preferred protocol

Dulbecco’s phosphate buffered saline, calcium, magnesium (DPBS; Thermo Fisher
Scientific, cat. no. 14040091)

Dulbecco’s phosphate buffered saline, no calcium, no magnesium (DPBS−;
Thermo Fisher Scientific, cat. no. 14190094)

Multi Tissue Dissociation Kits (Miltenyi Biotec, cat. no. 130-110-204)
BSA-based polyvinyl alcohol essential lipids (BPEL; see Ng, Davis, Stanley, &

Elefanty, 2008)
FBS (Biowest, cat. no. S00F910002)
Matrigel Basement Membrane Matrix, LDEV-Free (Corning, cat. no. 354234)
Paraformaldehyde (PFA; MilliporeSigma, cat. no. 158127-500G)
Triton X-100 (MilliporeSigma, cat. no. T8787)
Monoclonal anti-α-actinin (sarcomeric) antibody (MilliporeSigma, cat. no. A7811)
Donkey anti-Mouse IgG (H+L) (Thermo Fisher Scientific, cat. no. a-21203)
Tween 20 (MilliporeSigma, cat. no. P1379-100 ml)
4′,6-Diamidino-2-phenylindole, dihydrochloride (DAPI; Thermo Fisher Scientific,

cat. no. D1306)
Immersion oil, Type-F (Leica, cat. no. 11944399)

Personal computer (Windows or macOS) with at least 6 GB of RAM
SP8 white light laser fluorescent confocal microscope (Leica) or equivalent,

including well plate holder and 40× and/or higher objectives
Centrifuge (Eppendorf, cat. no. 5810R)
Aspirator
37°C humidified CO2 cell culture incubator (Sanyo)
Microscope for cell counting or an automated cytometer
Falcon tube (Thermo Fisher Scientific, cat. no. 14-959-53A)
5-, 10-, and 25-ml sterile plastic pipets (Greiner Bio-One, cat. no. 606180, 607180,

and 760180, respectively)

Figure 2 Strategic planning and time considerations for the protocol.
Stein et al.
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15- and 50-ml polystyrene conical tubes (Corning Falcon, cat. no. 352097 and
352098, respectively)

PIPETMAN Classic P200 and P1000 (Gilson, cat. no. F123601 and F123602,
respectively)

10-, 200-, and 1,000-μl filter tips (Corning, cat. no. 4807, 4810, and 4809,
respectively)

6-well plate (Falcon, cat. no. 353046)
Falcon 96-well black/clear flat bottom microplate (Corning, cat. no. 353219)

Sample preparation

NOTE: The hiPSC-CM culture, dissociation, and replating steps are performed under
aseptic conditions.

1. Thaw and culture commercially available hiPSC-CMs according to the manufac-
turer’s instructions. Alternatively, use hiPSC-CMs differentiated using a preferred
protocol (Breckwoldt et al., 2017; Correia et al., 2018; Current Protocols article: Gi-
acomelli, Bellin, Orlova, & Mummery, 2017; Mummery et al., 2012). High (>80%)
differentiation efficiency is recommended but not essential.

The protocol uses volumes recommended for 6-well plates except if stated otherwise.

2. Coat a thin-bottom 96-well plate with a 50-μl drop of Matrigel (1:100 in DPBS for
1 hr at room temperature.

Other tissue culture grade surfaces are acceptable, although they should be appropriate
for high resolution microscopy (equivalent to glass coverslips).

3. Prepare the dissociation reagent by adding 100 μl Enzyme T to 900 μl Buffer X
from the multi tissue dissociation kit.

4. Wash cells with DPBS− once (1 ml per well for 6-well plates) and aspirate.

5. Add Enzyme T/Buffer X mix to the well and incubate 10 min in a humidified incu-
bator (37°C, 5% CO2).

Other dissociation techniques are suitable, such as TrypLE express or collagenase. For
more information, see Koc, Sahoglu Goktas, Akgul Caglar, and Cagavi (2021).

6. Add 1 ml BPEL plus 10% FBS to the well. Collect the entire volume with a P1000
pipet and mechanically disrupt the cells in suspension by gently pipetting up and
down.

Critical step: Mix thoroughly but carefully. Cardiomyocytes are sensitive to mechanical
stress and resuspending too harshly might decrease yield.

7. Collect all cells in a 15-ml Falcon tube.

8. Rinse the well with 2 ml BPEL plus 10% FBS and add to the Falcon tube. Repeat
once.

9. Centrifuge cells at 300 × g for 3 min and remove supernatant.

10. Add 1 ml BPEL and resuspend.

11. Count cells manually or with an automatic cytometer.

12. Add 25,000 cells to the pre-coated 96-well plate in 200 μl BPEL.

CMs from different hiPSC lines tend to react differently to dissociation and replating.
Optimization of this step (e.g., seeding density) might be necessary to reach optimal vi-
ability and morphology. We recommend that the confluency be high enough for proper
cardiomyocyte morphology but not high enough to induce clumping.

Stein et al.
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13. Return to the humidified incubator and refresh BPEL after 24 hr.

Immunostaining hiPSC-CM monolayers in 96-well plates
14. After at least 3 days in culture, remove plates from the incubator and wash cells with

cold DPBS−.

The next steps are all performed at room temperature except when stated otherwise.

15. Fix cells with 4% PFA in 0.2 M DPBS, pH 7.4 for 10 min.

CAUTION: This step must be performed in a fume hood.

16. Wash three times with DPBS−.

17. Permeabilize with DPBS− with 0.1% Triton X-100 for 10 min.

18. Wash three times with DPBS−.

19. Block non-specific antibody binding for 1-2 hr with DPBS− plus 10% FBS.

20. Dilute primary antibody in DPBS− plus 10% FBS according to the manufacturer’s
instructions.

21. Remove blocking solutions and add the solution with the antibody to the cells. In-
cubate cells overnight at 4°C or 3 hr at room temperature.

Rocking the plate during this step can increase the penetration of the antibody and is
advised.

22. Remove the antibody and wash three times with DPBS− with 0.05% Tween 20 for
10 min.

23. Dilute the secondary antibody in DPBS− plus 10% FBS according to the manufac-
turer’s instructions.

Critical step: Do not expose either the antibody mix or the multi-well plate after this step
to direct light.

24. Add the secondary antibody to the cells and incubate 2 hr.

Rocking the plate during this step can increase the penetration of the antibody and is
advised.

25. Wash cells five times with DPBS− with 0.05% Tween 20 for 5 min.

26. Counterstain with 1:500 DAPI for 10 min.

Counterstaining is not strictly necessary for the sarcomere length detection but facilitates
identifying regions of interest during acquisition.

27. Wash with DPBS− with 0.05% Tween 20 twice.

28. Add a volume of DPBS− large enough to prevent drying.

Store the multi-well plate in a dark box or wrapped in aluminium foil to avoid exposure
to light; the cells can now be stored at 4°C for several days before imaging. For optimal
imaging, it is recommended that imaging be carried out <1 week after the immunostain-
ing.

Imaging the samples

This next step can be performed on various confocal microscope systems. The Leica SP8
is given as an example.

29. Turn on the Leica SP8 confocal microscopic system, the computer, and the Leica
imaging suite.Stein et al.
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Figure 3 Graphic user interface of the SotaTool, including advanced settings. See Support Pro-
tocol 2 for details.

30. Place the 96-well plate into the appropriate holder.

31. Select the appropriate objective.

Critical step: The highest magnification will give the best spatial resolution for sarcomere
length detection. An objective of at least 40× is recommended, preferably 63× and 100×
lenses. For improved signal, use the appropriate immersion fluid.

32. Activate the appropriate laser light using the Leica Dye Assistant.

33. Make sure all other settings are optimal for the best resolution and minimal back-
ground.

Either frame or line averaging is recommended to reduce background fluorescence.

34. Adjust objective so that the sarcomeres are in focus.

35. Acquire at least ten to fifteen images per condition.

Critical step: Keep all microscope settings identical for all acquisitions. If settings are
not kept identical, comparing different datasets or treatment conditions is impossible.

36. Export each image as a separate TIFF.

Analysis of images with the SotaTool

NOTE: The next steps can be carried out on any computer (PC) and/or laptop with suffi-
cient hardware (see Materials list), as the SotaTool is a stand-alone application requiring
no installation. Computing time will depend on the resolution, size, and bit-depth of the
raw images and the PC specifications. For one 1024 × 1024 TIFF with a bit depth of 16
and the default offset of 4 μm, the computing time is ∼50 s on a standard PC.

37. Transfer all TIFF images to a single folder.

Make sure the TIFF images all contain one image with sarcomeric staining (no stacks or
videos).

38. Download the entire software folder of the SotaTool (www.github.com/steinjm/
SotaTool) and place anywhere on the computer.

39. Double click on the executable file within the folder named SotaTool.exe.

40. Click ‘Browse’ to select the folder with the images to analyze (input directory,
Fig. 3).

41. Input the resolution (pixels per micron).

See Support Protocol 1.
Stein et al.
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42. Press ‘Start analysis’.

43. Check whether the output graphs are as expected.

See Troubleshooting (Fig. 6). A properly analyzed output graph shows a recurring sinu-
soid, where a vertical trendline is located at the first peak.

ALTERNATE
PROTOCOL

SAMPLE PREPARATION, ACQUISITION, AND QUANTIFICATION OF
FRACTIONAL SHORTENING IN LIVE REPORTER hiPSC LINES

This protocol describes the analysis of videos of hiPSC-CMs expressing a mEGFP-
tagged ACTN2 protein from an ACTN2-GFP WTC hiPSC line (Roberts et al., 2019).
In choosing which tagged sarcomere proteins are best to use, the same recommendations
apply as for static images (see introduction of Basic Protocol). ACTN2-reporter cells
were differentiated using a modified version of Giacomelli et al. (2017). Analyses of
phase-contrast images or live acquisitions of neonatal rabbit cardiomyocytes using Sota-
Tool are identical; a protocol for the isolation of these cells can be found in MacQuaide,
Ramay, Sobie, and Smith (2010).

Additional Materials (see also Basic Protocol)

hiPSC-CMs with a mEGFP-tagged ACTN2-reporter: Allen Institute for Cell
Science ACTN2-GFP WTC iPSC line (AICS-0075-085,
https://hpscreg.eu/cell-line/UCSFi001-A-4 with mEGFP inserted at ACTN2
C-terminus, obtained from Coriell Institute for Medical Research)

Andor Dragonfly 500 spinning disc inverted confocal microscope
Personal computer equipped with Andor Fusion software for microscopy and

analysis (Oxford Instruments Andor, version 2.3)
On-stage incubator
Electric field stimulator (homemade or equivalent commercially available device,

e.g., IonOptix myopacer cell stimulator)

Preparing the samples

The following steps are performed under aseptic conditions.

1. Perform steps 1-13 of Basic Protocol.

2. Thaw cells according manufacturer’s instructions and plate on a thin-bottom 96-well
plate.

3. Allow cells to recover for 24 hr and refresh medium.

Imaging the samples

NOTE: In order to extract sufficient data on the time dynamics and spatial resolution of
the sarcomeric contraction, a frame rate of >50 frames per second (fps) is recommended
for acquisition of live images on video. Note, this frame rate depends on the beating
(and/or stimulation) frequency. For this purpose, we use an Andor Dragonfly spinning
disc 500 with an on-stage incubator but an equivalent (widefield) system can be used as
well.

4. Start the Andor Dragonfly spinning disc confocal system, detectors, lasers, and on-
stage incubator.

5. Wait for the on-stage incubator to achieve appropriate conditions (37°C, 5% CO2).

6. Mount the multi-well plate onto the microscope.

7. Start the Fusion software.
Stein et al.
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8. Perform steps 30-37 of Basic Protocol.

Critical step: For the laser settings, choose the 488-nm laser line for excitation. Exposure
time should be kept low to achieve high fps. The histogram should have a range of at least
256 bits.

Use the appropriate immersion fluid suitable for imaging at 37°C.

9. Place the electrodes of the field stimulator in the 96-well plate and pace the cells.

Steps 9 and 10 are optional. However, we recommend imaging the cells with and without
field stimulation to gain optimal insight in the contractile behavior and spontaneous beat
rate.

10. Check whether the cells are “following” the imposed pacing rate.

We recommend 1.2 Hz with 5 ms duration and voltage of 15 mV bipolar pulse. If cells
exhibit a fast spontaneous beat rate, higher simulation frequencies are required to avoid
arrhythmic contractions. If the cells do not follow at all, increase the duration and voltage
of the pulse.

11. Acquire images.

We recommend acquiring a movie consisting of at least four contractions. For example,
when imaging at 50 fps and pacing at 1.2 Hz, acquire around 180 frames per position.

12. Export each image as a separate TIFF.

Ensure the timestamp is properly added to either the name or meta data of each frame.
When using the Andor Dragonfly, an ImageJ macro can be found on www.github.com/
steinjm/SotaTool to export all .ims-files in a folder to single TIFF files ready for analysis
with SotaTool.

Extracting the fractional shortening using the SotaTool
13. Perform steps 39-47 from Basic Protocol.

14. Open the sheet with the sarcomere lengths in any preferred data visualization soft-
ware (e.g., Excel, R-Studio, Graphpad).

An R-script can be found on www.github.com/steinjm/SotaTool for automated peak de-
tection and calculation of relevant read-outs such as sarcomeric shortening, beat-beat
interval, and beat duration, along with instructions for use.

15. Plot the sarcomere length on the y-axis against the timestamp on the x-axis for each
separately acquired movie.

16. Note the maximum sarcomere and minimum sarcomere length and calculate the
difference.

17. Divide the distance of shortening by the maximum length × 100% for the fractional
shortening of that cell.

To increase technical robustness, these last two steps can be done for each individual
contraction in a movie. Using healthy cells, this fractional shortening would not differ
noticeably between contractions. If this is not the case, the mean fractional shortening of
all contractions should be calculated.

SUPPORT
PROTOCOL 1

FINDING THE IMAGE RESOLUTION

This protocol describes the steps to determine resolution and offset distance from the
image metadata.

Stein et al.
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Hardware

Personal computer (Windows or macOS) with at least 6 GB of RAM and access to the
Internet

1. Download FIJI (or ImageJ) for the operating system of your computer from the fol-
lowing link: https:// imagej.net/ software/fiji/?Downloads).

2. Start the software.

3. Navigate to ‘File’ → ‘Open…’ and open the TIFF (or press CTR + O).

4. Navigate to ‘Image’ → ‘Show Info’ (or press CTR + I).

5. Note the resolution (pixels per micron).

If only the pixel size is found, calculate the resolution by 1/pixel size.

SUPPORT
PROTOCOL 2

ADVANCED ANALYSIS SETTINGS

The following section describes the settings as shown in Figure 3.

Hardware

Personal computer (Windows or macOS) with at least 6 GB of RAM and access to the
Internet

1. Background subtraction greatly enhances the image quality and therefore increases
accuracy of the algorithm. This is turned on by default and always recommended
when no prior background subtractions have been performed on the raw data.

2. Segmentation automatically segments the original images and saves them in a sub-
folder for subsequent analysis.

See Support Protocol 3.

3. The offset distance is automatically defined as 4 μm but in this box the user can
manually define the maximum offset distance. This greatly reduces computing time.
It is crucial that the offset distance is not smaller than the expected sarcomere length.

4. Rolling ball size is automatically defined as 2 μm, which is optimized for hiPSC-
CMs. Here, the user can manually override this ball size.

5. Gray-level co-occurrence matrix (GLCM)-filtering filters out the lowest gray values
of the original image by disregarding the first columns and rows of the GLCM before
calculating the correlation value. We have found the best default number to be three
but the user can input a manual override here.

See Background Information section for more information.

6. In this box, the user can insert the maximum expected sarcomere length. This feature
is useful when there is noise in the image.

7. Skip graphs to save time. We do not recommend skipping the output graphs as this is
the only way to verify the analysis has been performed correctly.

8. When this box is checked, an additional .csv file is exported in the output directory
with the interpolated data.

SUPPORT
PROTOCOL 3

FINDING SARCOMERE LENGTH IN NON-ALIGNED CELLS

The following section describes the steps needed to take multiple measurements for non-
aligned cells.Stein et al.

10 of 18

Current Protocols

 26911299, 2022, 7, D
ow

nloaded from
 https://currentprotocols.onlinelibrary.w

iley.com
/doi/10.1002/cpz1.462 by U

niversity O
f T

w
ente Finance D

epartm
ent, W

iley O
nline L

ibrary on [15/02/2023]. See the T
erm

s and C
onditions (https://onlinelibrary.w

iley.com
/term

s-and-conditions) on W
iley O

nline L
ibrary for rules of use; O

A
 articles are governed by the applicable C

reative C
om

m
ons L

icense

https://imagej.net/software/fiji/?Downloads


Additional Materials (also see Basic Protocol)

Personal computer (Windows or macOS) with at least 6 GB of RAM and access to the
Internet

1. Perform Basic Protocol.

2. Check whether the program outputs values for sarcomere length or 0 values only.

3. Check the output graphs.

See Troubleshooting section.

4. If there are no peaks visible, segmentation might be necessary to find proper sarcom-
ere length values.

See Troubleshooting section.

5. Repeat the analysis on the raw images but check ‘Segmentation’ before starting anal-
ysis.

This function will create a subfolder named ‘segments’ for saving the segments. If a new
analysis is started with new segmentation settings, this folder will be emptied and new
segments will be saved. Make sure there is enough free memory on the PC for the segmented
images.

6. Check the output sheet. For each image, the segment with the highest sarcomere or-
ganization score has the most reliable sarcomere length but the mean of multiple
(properly analyzed) segments can also be used.

COMMENTARY

Background Information
Analysis of sarcomere length of static 2D

muscle cells and fractional shortening of live
cells in 3D is usually time consuming, requires
considerable manual labor, and is highly prone
to user-selection bias. For this reason, we
created a versatile, robust, and rapid method
for sarcomere length quantification of many
different muscle models in an open-source
stand-alone Python-based application as an
extension of the algorithm developed by Sut-
cliffe et al. (2018).

This method is based on GLCM (Haralick,
Shanmugam, & Dinstein, 1973), which trans-
lates images into arrays of i columns and j
rows, one for each gray level of the original
image (Fig. 4A). From one GLCM, a correla-
tion value is calculated over the entire image,
which is a measure of the linear dependency
for gray-value combinations over a distance g
(Fig. 4B). The algorithm calculates the corre-
lation values for 180 angles (α) over 1-g pixel-
pixel distances (Fig. 1A).

Repeated striations in the image (such as
sarcomeres) result in damped oscillating cor-
relation graphs. To extract the direction in
which the striations are most clearly present,
the algorithm finds and selects the angle α at
which the correlation peak is maximum. At
this point, the striation-striation distance (i.e.,

the x-axis offset of the highest peak) can be
determined (Fig. 1). This x-axis offset is de-
fined as the distance g in the angle α where the
highest linear dependency between gray val-
ues over the entire image is found.

By using automatic and whole-image
analysis, manual labor and selection bias are
decreased, because no input is required from
the user except for an optional maximum mi-
crometer offset to minimize computing time.
Most importantly, the selection of areas to
measure and drawing of lines for fast Fourier
transformation (FFT) analysis, as done in
most current practices, is not required. Most
current automated analysis software is reliant
on segmentation or single point tracking
of the sarcomere signal, which decreases
throughput or robustness in 3D stainings of
sarcomeres where there is often a higher
signal/noise ratio (Toepfer et al., 2019). Aside
from the sarcomere length and the direction
of the striations, this algorithm also out-
puts a measure of sarcomere organization
(the maximum peak value of the correlation
graphs; Sutcliffe et al., 2018) and an align-
ment coefficient (the variation between all the
curves on the previously calculated sarcomere
length; Gerbin et al., 2021). Furthermore,
two other Haralick features are incorporated
in the output. The uniformity (also known Stein et al.
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Figure 4 Visualization of the GLCM. (A) For each pixel in the original image, p(ij) is the number
of times that gray-level j occurs at a certain pixel offset g from gray-level i. (B) From each GLCM,
a correlation feature is calculated, which results in a damped sinusoid shape when plotted against
the offset if unidirectional striations are present in the image. (C) Filtering of the GLCM is performed
before calculating the correlation values, by disregarding the first rows and first columns (the lowest
bins of gray values) of the unnormalized GLCM. (D) This positively affects the dynamic range of
the sarcomere organization score and the success rate (E), but not the sarcomere length. GLCM,
gray-level co-occurrence matrix.

as the angular second moment) is higher in
uniform images, where 1 is a completely uni-
form image. The homogeneity (or the inverse
difference moment) which represents image
contrast, has a higher value for homogeneous
images (Haralick et al., 1973; Sutcliffe et al.,
2018).

One limitation of this algorithm is that im-
ages with morphologically adequate but mis-
aligned sarcomeres do not produce correlation
peaks. Therefore, we included an automated
cropping step which segments the image
in a user-defined manner. These segments
are subsequently analyzed. In a dataset with
non-aligned hiPSC-CMs cultured on stan-
dard tissue culture plastic, this increased the
successful analysis of the images from 57%
to 100% (see Fig. 1B). It results in a higher
number of analyzed datapoints per image and
requires post-processing user input to dis-
tinguish correctly from incorrectly analyzed
segments. Another limitation of this method
is that the metric for organization score has a
narrow range, from 0 for disorganized to ∼0.3
for organized striations. We found that disre-
garding the first row and first column of the
GLCM (where i and j are 0) greatly reduced
the background and increased the baseline
sarcomere organization score, and thereby the
dynamic range of the output (Fig. 4D). This
method also increased the success rate of peak
detection and sarcomere length calculation

in low-quality cells but did not affect the
sarcomere length (Fig. 4E). It should be noted
that altering the value for GLCM filtering (see
Fig. 3, Advanced settings, step 5) and the
value of the “rolling ball background sub-
traction” alters the sarcomere score and
alignment but not the sarcomere length. For
hiPSC-CMs, we found a filter of 3 is optimal
but the user can override this in Advanced
settings, step 5. To ensure broad applicability,
the software does not take cell boundaries
into account. Segmentation can be performed
in tertiary software, such as CellProfiler
(www.cellprofiler.org).

Multiple types of datasets containing stri-
ated images were analyzed and compared
to other relevant methods. As shown in
Figure 5, correlation of these datasets mea-
sured with SotaTool and the other methods
resulted in a minimal R2 of 0.862 among all
tested datasets with p-values below .0001.

For the immunostained hiPSC-CMs cul-
tured on micropatterned substrates (Birket
et al., 2015), we performed manual length de-
tection by creating manual line scans over the
sarcomeres in ImageJ and measuring the av-
erage peak-to-peak distance. We found higher
correlations between the methods and de-
creased absolute difference per datapoint upon
increasing technical repeats of the manual
detection (data not shown). This indicates
that the sarcomere lengths resulting from theStein et al.
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Figure 5 The SotaTool can analyze multiple types of datasets from 2D, 3D, static (fixed), and
live muscle cell cultures. Datasets were analyzed with SotaTool and the gold standard for each
model. Sarcomere lengths of (A) hiPSC-CMs and (B) 3D tissue engineered skeletal muscles were
compared with manually determined sarcomere lengths. Linear regression shows that the results
from the algorithm (y axis) correlated with the results from the manual detection method (x axis;
hiPSC-CM: p = 5.6 × 10-8, scale bar = 15 μm. hiPSC-SM: p = 1.6 × 10-6, scale bar = 30 μm). (C)
High speed phase contrast recordings of isolated neonatal rabbit cardiomyocytes were analyzed
with the SotaTool. In a linear regression, the normalized fractional shortening indicated by the
SotaTool correlated with the normalized fractional shortening found with fast Fourier transform (p =
4.1 × 10-5). Scale bar = 10 μm. (D) hiPSC-CMs transduced with an mEGFP-tagged ACTN2 protein
were also analyzed in a similar fashion and peak-to-peak intervals were compared to analysis with
MUSCLEMOTION software (p = 1 × 10-51, scale bar = 10 μm). hiPSC-CMs, human induced
pluripotent stem cell-derived cardiomyocytes; hiPSC-SM, human induced pluripotent stem cell-
derived skeletal muscle.

algorithm are closer to the ground truth as it
takes all the striations in an entire image into
account, whereas manual detection is limited
by selection bias and sampling error. For the
final analysis with ten manual line scans, the
R2 was 0.904 (Fig. 5A).

We applied the same method of manual
detection and SotaTool analysis of images of
hiPSC-derived skeletal muscle fibers cultured
in 3D stained for titin. These images were cho-
sen because the sarcomeres differ morphologi-
cally from those in hiPSC-CMs. SotaTool was
able to detect striations successfully and the
sarcomere length scores corresponded to those

using manual detection (R2 = 0.862) taking 5
ROIs per image (Fig. 5B).

Videos of neonatal rabbit CMs with a frame
rate of 100 fps were analyzed as single TIFF
images (Fig. 5C). The resulting sarcomere
lengths in contracted and relaxed state were
subtracted, resulting in the fractional shorten-
ing. These were normalized and compared to
the normalized shortening obtained using FFT
analysis (Sala et al., 2018). The measurements
from the two methods correlated with an R2 of
0.891.

The live mEGFP-tagged ACTN2 reporter
cells were recorded with a frame rate of

Stein et al.
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Video 1 Side-by-side view of contracting sarcomeres in hiPSC-CMs expressing ACTN2-GFP
and the SotaTool output graphs. hiPSC-CMs, human induced pluripotent stem cell-derived car-
diomyocytes.

50 fps and analyzed in a similar fashion and
the beat rate was quantified (Fig. 5D). After
SotaTool analysis of all the separate frames,
the peaks were analyzed by a custom script
in R-studio, which correlated with MUSCLE-
MOTION (R2 = 0.944; Sala et al., 2018).
See Figure 8 for a representative acquisition
of the reporter CMs along with the corre-
sponding correlation graphs. Depending on
the question, pacing of hiPSC-CMs might be
considered. For example, the basal beat rate of
hiPSC-CM can be variable between different
differentiations or conditions which hampers
comparison of absolute output parameters
if they are not paced. On the other hand, to
detect, for example, chronotropic changes,
acquisition of images from spontaneously
contracting cardiomyocytes are highly
informative.

Analyzing live reporter cells with fluores-
cently tagged sarcomeres has several advan-
tages over static cultures in which sarcomeres
are immunostained. Firstly, live reporters can
be monitored in real time over long periods,
while immunostaining is a terminal end-point
measurement. Secondly, in fixed cardiomy-
ocytes, it is not possible to determine which
cells are in systole, diastole, or an interme-
diate contraction/relaxation state; this may
affect the sarcomere distance quantification.
This is not an issue in live reporter cells
where imaging is continuous. Moreover, PFA
fixation can cause artefacts like cell shrinkage
and disruption of cell organelles (Schnell,
Dijk, Sjollema, & Giepmans, 2012). Of note
though, live cell fluorescent microscopy at
a high frame rate can cause phototoxicity in
the cells or bleaching of the fluorescent signal
and significantly more data-storage capacity

and analysis time is needed for live cell image
acquisition.

Critical Parameters
A single monolayer of cells is preferred be-

cause hiPSC-CMs are easier to image and ana-
lyze than hiPSC-CMs that have formed multi-
ple layers. This is highly dependent on seeding
density but selecting the correct hiPSC-CM
seeding density occasionally requires some
optimization. We recommend trying differ-
ent seeding densities (e.g., 16k/cm2, 31k/cm2,
78k/cm2, 156k/cm2, 234k/cm2, 313k/cm2,
where k = × 103) due to varying recovery effi-
ciencies during passaging and following thaw-
ing after cryopreservation in different hiPSC-
lines. Aside from the seeding density, the mor-
phology can vary upon use of different coating
proteins, e.g., Geltrex, fibronectin, or laminin
instead of Matrigel.

For proper quantification of sarcomere
length, the pixel size is the largest factor in-
fluencing the final result. Therefore, the im-
ages should not be “binned” during or after
imaging. Moreover, an objective of over 40×
is preferred for imaging. Due to the interpola-
tion method of the algorithm, images derived
using lower magnification objectives can also
be analyzed to a certain extent but artefacts and
incorrectly analyzed images may occur. For
successful comparison of multiple datasets,
the settings of the camera, laser, and SotaTool
should always be identical. The same applies
to the antibody dilutions and the incubation
times during immunostaining.

Troubleshooting
After successful analysis, the output graph

should look like Figure 6A. If there are insuf-
ficient recurring anisotropic striation patterns

Stein et al.
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Figure 6 Examples of good output and bad output graphs, along with troubleshooting options.
Note that the numbers indicate different possible solutions and not steps to one solution. (A) Ex-
ample of properly analyzed output image. The vertical trendline is located on the highest peak. (B)
Result of faulty analysis due to the absence of alignment in the input image (see Support Protocol
3). (C) If the highest peak is not the first peak, this could indicate noise in the image. Either the
offset distance or a maximum sarcomere length filter can be user defined in the advanced settings
interface (step 3 and 6, respectively). (D) In this instance, only a small number of pixels have been
analyzed, possibly because the pixel size was used instead of the resolution (i.e., pixels/μm). (E)
When the graph morphology is as expected but the trendline is at 0, this means the maximum sar-
comere distance entered in advanced setting 6 is too low. (F) When the LUT of a 16-bit image has
a large range (e.g., 0-65,536) but the intensity histogram is small (e.g., 100-500), this can result in
all gray values of interest being in the same bin. To ensure proper analysis, these images are best
pre-processed in ImageJ. Navigate to ‘Image’ → ‘Adjust’ → ‘Brightness/Contrast…’ and adjust the
brightness and the contrast to the required level (LUT-range of around 255) and press “Apply”. Save
the image and re-run the analysis. It is crucial to choose the same range across a larger dataset.
GLCM, gray-level co-occurrence matrix; LUT, look up table.

in the image, the output will look like Fig-
ure 6B. In this case, the user should opt for
the automated segmentation step during anal-
ysis (see Support Protocol 3). If this still does
not result in successful analysis of images, the
user might use ImageJ or Photoshop to man-
ually select an area of interest. Note that the
organization parameters of manually cropped
images cannot be compared to the organiza-
tion of other unsegmented images. In certain
cases, a recurrent noise signal can lead to out-
put graphs like Figure 6C: Choosing maxi-
mum offset or maximum sarcomere distance

will solve this. If an output graph looks like
Figure 6D, most likely the pixel size is en-
tered instead of the resolution, which should
be in pixels/μm. If the value for the maximum
sarcomere length is set too low, the output will
look like 6E.

The GLCM is created by binning the orig-
inal image in 256 gray values. When images
with a bit depth higher than 8 are analyzed,
this can result in all gray values being in the
same bin (Figure 6F). These images should
be pre-processed in ImageJ. Navigate to ‘Im-
age’ → ‘Adjust’ → ‘Brightness/Contrast…’ Stein et al.
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Figure 7 Flowchart of the algorithm. Optionally, single TIFF images in a folder can be segmented
in a user-defined fashion and the segments are saved in a subfolder of the input directory. After
optional (but defaulted) background subtraction, GLCMs are created for each angle and for g pixel
offsets and 180 angles. From each GLCM a correlation value is calculated, which is saved as a
table. Peak height is calculated for each angle and from the peak with the maximum value the sar-
comere organization score is quantified. At this offset, the alignment index is also calculated, as
the coefficient of variation of all datapoints at that offset. The selected graph with maximum orga-
nization score is interpolated for subpixel accuracy of the sarcomere length. Per image, a graph is
saved with all angles, the interpolated graph and its raw datapoints, and a trendline on the sarcom-
ere length. Per dataset, a summary table is saved with measurements for each (segmented) image
along with an optional .csv file with the interpolated datapoints. GLCM, gray-level co-occurrence
matrix.

and adjust the brightness and the contrast to
the required level and press “Apply”. Save the
image and re-run the analysis. Preferably, the
same range is chosen across a larger dataset.

If the program directly stops running with-
out an output folder being made, this might
indicate a faulty input folder, or one with re-
stricted or password-protected access. If an
output folder is made but has no content, make
sure the file extension is .tif.

Understanding Results
This protocol describes an automated

analysis pipeline of multiple types of data.
An overview of the input, output, and algo-
rithm steps are given in Figure 7. Broadly,
after two optional pre-processing steps
(background subtraction and segmentation),
the GLCM is calculated, and the raw data is

saved per image as a comma delimited file
(.csv). The curve with the highest peak is
isolated from all the generated curves and
the sarcomere organization score calculated
as the difference between the height of the
peak and its preceding minimum. At the offset
distance of the maximum peak, the variance
between all curves is taken as an alignment
index. The sarcomere length is calculated
from the maximum peak after interpolating
with a bicubic spline, for sub-pixel accuracy.
Per image, a graph is saved containing (1)
all curves of all angles, (2) an overlay of
the interpolated maximum graph, (3) its raw
datapoints, and (4) a trendline visualizing the
sarcomere length for that image. For the entire
dataset, another .csv file is saved containing
the file names, sarcomere lengths, angles,
sarcomere organization score, and alignmentStein et al.
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index. Optionally, the interpolated data can be
saved per image as .csv (see Fig. 3, Advanced
settings, step 8).

Time Considerations
For staining and analyzing static hiPSC-

CMs with SotaTool, output can be generated
within 5 days (Fig. 2), depending on the re-
covery of the cells after the thawing or seed-
ing protocol. The immunostaining protocol in-
cludes an overnight incubation. Hands-on time
during this section (Basic Protocol, steps 14 to
28) is ∼1 hr for twenty wells. The second day
of the immunostaining protocol is short (Ba-
sic Protocol, steps 22 to 28, <4 hr), and can
be immediately followed by microscopy and
data analysis. For imaging and analyzing live
reporter cells, the entire experiment is shorter
(∼4 days, depending on the cell recovery),
because no staining procedures are needed.
However, data organization and analysis can
take a considerable amount of time depend-
ing on the fps, resolution, size, and hardware
specifications of the computer, though Sota-
Tool can run without user supervision.
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